# Table of Content

- **Nortech Client Software** ................................................................. 5  
  - Sentinel ......................................................................................... 6  
  - EasyGrid ....................................................................................... 6

- **Instrument Accessibility with the Software** .................................. 6  
  - Sentinel ......................................................................................... 6  
  - EasyGrid ....................................................................................... 6

- **Getting Started with the Nortech Client Software** ......................... 7  
  - Installing the Program .................................................................. 7  
  - Accessing the Program .................................................................. 7

- **Working with the Nortech Client software** ........................................ 8  
  - Main Screen .................................................................................. 8  
  - Changing temperature scale ............................................................ 9  
  - Connecting the Sentinel .................................................................. 9  
  - Connecting the EasyGrid ................................................................. 10  
  - Configuring Network and Communication Parameters ...................... 11

- **Monitor Tab** ................................................................................. 12  
  - Grid view ....................................................................................... 12  
  - Graph view .................................................................................... 13  
  - Bottom section ............................................................................ 14

- **Data Logging tab** ........................................................................ 15  
  - Mega logger Configuration ............................................................. 16  
  - Internal Memory ........................................................................... 18  
  - Memory Card ................................................................................ 19  
  - Event Logger ................................................................................ 20

- **Log viewer** .................................................................................. 22  
  - Mega logs viewer ........................................................................ 22  
  - Grid ................................................................................................. 23  
  - Graph .............................................................................................. 24  
  - Memory Card Viewer ..................................................................... 25  
  - Remote .......................................................................................... 26  
  - PC ................................................................................................. 27  
  - Event logs viewer .......................................................................... 28

- **Relay tab** ..................................................................................... 29  
  - Alarm config ................................................................................ 29  
  - Example ....................................................................................... 32  
  - Relay config ................................................................................ 33  
  - System relay ................................................................................ 34  
  - Relay status ................................................................................ 34

- **Hardware tab** ............................................................................. 35  
  - Channel Setup & Analog Output Scale ............................................. 35  
  - System date and time .................................................................... 37
Front panel led output................................................................................................................. 38
Transformer information............................................................................................................. 38
Firmware update.......................................................................................................................... 39
User configuration archive......................................................................................................... 42
Graph control functions.............................................................................................................. 43
Legend ......................................................................................................................................... 43
Zoom ........................................................................................................................................... 44
Scroll .......................................................................................................................................... 44
Save........................................................................................................................................... 44
Nortech Client Software

The Nortech Client software is used to configure the Nortech system and retrieve the data stored in the unit. Communication between a PC and the Nortech Unit may be established through the RS-232 (Sentinel) or the USB (EasyGrid) interface.

The main functions are:

- Real-time display of Nortech Sentinel and EasyGrid temperature measurements, statistics and settings.
- Configuration and control of the Nortech Sentinel and EasyGrid units.
- Retrieval and display of the logged data from Mega Logger and Event Logger (unavailable on Sentinel Lite).
- Configuration and monitoring of relays / alarms (unavailable on Sentinel Lite).

The minimum system requirements are:

- Intel® Pentium® 4 or compatible processor at speed above 1 GHz
- Microsoft Windows® XP, Vista or 7
- Monitor resolution at 800 × 600
- At least 512 MB of RAM and 100 MB of available hard disk space
- CD-ROM or DVD-ROM drive
- A mouse or similar pointing device.
- RS-232 interface or USB Interface with USB to RS-232 converter (Sentinel).
- USB interface (EasyGrid).
Instrument Accessibility with the Software

Sentinel

The PC needs to be connected to the unit using one of the serial interfaces (RS-232 or RS-485). If you don’t have a serial port on your PC, you can use a USB to serial converter. You can get one locally in your area or order one from Fiso with the part number SEN-CONV-USB.

IMPORTANT
The communication switch on the unit’s connector panel must be in the left position.

EasyGrid

A USB cable from your PC to the USB port located behind the configuration door on the right of the unit display should be used to establish the communication.

IMPORTANT
Open the maintenance door on the right side of the EasyGrid for USB connection.
Getting Started with the Nortech Client Software

Installing the Program

To install the software for the first time on the computer:

1. Place the CD-ROM provided with the Nortech Unit on the CD-ROM drive. If auto run does not start, open Windows Explorer to view the CD-ROM’s contents and double-click on setup.exe.

2. The Install Shield Wizard will automatically start.

3. Click Next to proceed with the installation.

4. When the installation is over, click Finish to exit the Wizard.

Accessing the Program

The program installation adds a shortcut to the desktop, so it can easily be launch with the Nortech Client desktop shortcut. The program shortcut should also be found in the installed program list, under FISO Technologies. The complete access menu is:

Start ► All Programs ► FISO Technologies ► Nortech Client ► Nortech Client.
Working with the Nortech Client software

Main Screen
The main screen is composed of different sections:

- **Menu bar**
- **Toolbar**
- **Information Tabs**
- **Device list**
- **Selected Device Information**
- **Tabs Specific Area**

Main interface of the Nortech Client software

The **Menu bar** and **Toolbar** give quick access to port selection, connection, network configuration, firmware update, log viewer and temperature scale.

The **Device list** shows all instruments that have been detected on the network. The list can be refreshed with the Refresh network button.

The **Selected Device Information** section presents detailed information about the instrument highlighted in the device list.

The **Information Tabs** controls the right side of the window. These tabs provide all the information available from the Nortech Sentinel and EasyGrid units.

**Note:** Data Logging and Relay information are not available with the **Sentinel Lite**.
Changing temperature scale

Temperature values can be displayed in Celsius (°C) or in Fahrenheit (°F).

User can change temperature scale anytime, from the View -> Scale menu or the temperature scale toolbar button.

Connecting the Sentinel

1. Don’t forget to set the communication switch on the left side on the devices.
2. Connect your device to the PC via a serial cable.
3. In the Toolbar menu, select the proper port from the list.
4. In the Toolbar press on the Connect button.
Connecting the EasyGrid

1. Unlock both screws and open the maintenance door, connect a USB cable to the USB port.

2. Connect the other end of the USB cable to the PC.

   On the first connection, Windows might need to download and install the FTDI USB driver which is available on windows update. To install the driver manually, browse the software installation CD and launch CDM20814_Setup.exe located in the Driver folder, or download the driver online from FTDI website, vcp driver: http://www.ftdichip.com/Drivers/VCP.htm.

3. Device serial number should appear in the port list. Select the proper port.

4. Click Connect to open communication.

Once connected, a list of detected devices is displayed on the left of the main window. To refresh network detection, click Refresh network. It will scan the network to detect all devices. Network scan can be stop anytime when connected units have been detected.

![Network Detection](image)

**IMPORTANT**

If your device list is empty or not reflecting the connected device, press on the Refresh Network button before reporting a problem.

To close connection, use the Disconnect button.
Configuring Network and Communication Parameters

To open the Network Config window from which you may configure and manage network parameters, select the device to update from the device list and click on the **Network Config** button into the toolbar or in the Tools menu.

Network communication info of the selected device is displayed. It can be refreshed via the **Refresh** button. Nortech address (which is used by Nortech Client software) and Modbus parameters can be modified according to your network specifications.

**IMPORTANT**

To avoid any communication conflict, be sure to set different addresses to each instrument linked together. It is also recommended to assign consecutive address numbers to the units in the same network, starting with number one.

Click on the **Apply** button to send updated information to the unit.
Monitor Tab

The **Monitor Tab** provides the real-time, channels temperature measurements, statistics and diagnostics of the units. User can select between two different displays: Grid or Graph. The refresh rate can be adjusted to increase or decrease real-time monitoring speed.

**Grid view**

The grid view shows real-time, measurements, statistics and diagnostics of all units and each channel connected on the network. Use the checkbox to show or hide statistics and diagnostics columns on the grid. The internal system temperature and system status of the selected device are also displayed. To reset statistic(s) you must check mark the channels you want to erase and click on the appropriate Reset Stats button (maximum, minimum, average or all).
Graph view

The graph view plots latest temperature measurements of the selected device in the list. Graphic time duration can be adjusted from 10 seconds up to 1 day (days: hours: minutes: seconds). Use the **Start** button to activate the chart, and the **Stop** button to end the monitoring. If you need to reset the chart data, press **Reset** button.

*For the chart functionality, please refer to the Graph control functions section.*

---

**IMPORTANT**

Chart data will be cleared on change of device selection. Temperature values are not monitored when another tab is selected.
**Bottom section**

Mega logger (internal + memory card for EasyGrid), event logger and alarm relay status of the selected device are displayed in the bottom section of the Monitor tab. When the Mega logger is running the LED is green, when stopped the LED is red. Relays status LED are changing colors depending their condition:

- In alarm mode: red
- Enabled but no alarm: green
- Exercising: yellow
- Disabled: black.

![Nortech Client Software Monitor Tab (Easygrid)](image-url)
Data Logging tab

The **data logging tab** is used to configure, view and save data logger information of the selected unit in the device list. There are two types of data logging on the unit, the mega logger which saves data on a regular cycle, and the event logger who saves data when a particular event occurs.

![Nortech Client Software Data Logging Tab](image)

⚠️ IMPORTANT

To get valid timestamps in the logs, don’t forget to set the System date and time. *See bottom section in Hardware tab.*
Mega logger Configuration

To edit the mega log configuration, the logger should not be activated (Press the **Stop** Button if it is still running).

Select the desired Log Type between Standard (less info, more logging capacity) or Enhanced (more info, less logging capacity).

The table below shows the difference between the two types of log.

<table>
<thead>
<tr>
<th>Model</th>
<th>Log type</th>
<th>Date</th>
<th>Status</th>
<th>Current temp.</th>
<th>Temperature stats.</th>
<th>Diagnostic</th>
<th>Internal temp.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Relays</td>
<td>Sensors</td>
<td>Min.</td>
<td>Avg.</td>
<td>Max.</td>
</tr>
<tr>
<td>Sentinel II</td>
<td>Standard</td>
<td>☑</td>
<td>☑</td>
<td>☑</td>
<td>☑</td>
<td>☑</td>
<td>☑</td>
</tr>
<tr>
<td>Sentinel II</td>
<td>Enhanced</td>
<td>☑</td>
<td>☑</td>
<td>☑</td>
<td>☑</td>
<td>☑</td>
<td>☑</td>
</tr>
<tr>
<td>EasyGrid</td>
<td>Standard</td>
<td>☑</td>
<td>☑</td>
<td>☑</td>
<td>☑</td>
<td>☑</td>
<td>☑</td>
</tr>
<tr>
<td>EasyGrid</td>
<td>Enhanced</td>
<td>☑</td>
<td>☑</td>
<td>☑</td>
<td>☑</td>
<td>☑</td>
<td>☑</td>
</tr>
</tbody>
</table>
The log type affects the number of logs that can be stored in the unit. The table below indicates those differences.

<table>
<thead>
<tr>
<th>Model</th>
<th>Memory Type</th>
<th>Log Type</th>
<th>Maximum Log Count</th>
<th>Capacity @ 1 log / 1 min</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sentinel II</td>
<td>Internal</td>
<td>Standard</td>
<td>483 328</td>
<td>~ 336 days</td>
</tr>
<tr>
<td>Sentinel II</td>
<td>Internal</td>
<td>Enhanced</td>
<td>241 664</td>
<td>~ 168 days</td>
</tr>
<tr>
<td>EasyGrid</td>
<td>Internal</td>
<td>Standard</td>
<td>120 832</td>
<td>~ 84 days</td>
</tr>
<tr>
<td>EasyGrid</td>
<td>Internal</td>
<td>Enhanced</td>
<td>60 416</td>
<td>~ 42 days</td>
</tr>
<tr>
<td>EasyGrid (8 Channels)</td>
<td>Memory Card (4 GB)</td>
<td>Standard</td>
<td>~ 124 567 200</td>
<td>~ 237 years</td>
</tr>
<tr>
<td>EasyGrid (8 Channels)</td>
<td>Memory Card (4 GB)</td>
<td>Enhanced</td>
<td>~ 36 266 400</td>
<td>~ 69 years</td>
</tr>
<tr>
<td>EasyGrid (18 Channels)</td>
<td>Memory Card (4 GB)</td>
<td>Standard</td>
<td>~ 66 225 600</td>
<td>~ 126 years</td>
</tr>
<tr>
<td>EasyGrid (18 Channels)</td>
<td>Memory Card (4 GB)</td>
<td>Enhanced</td>
<td>~ 16 819 200</td>
<td>~ 32 years</td>
</tr>
</tbody>
</table>

**IMPORTANT**

The system will clear all mega logger data every time you change the log type configuration.

The Memory Mode defines the action taken when the internal memory of the mega logger is full. The system can either continue logging “Continuous” (erasing the oldest record when memory is full) or stop logging any data “Stop when full”.

For the EasyGrid, the internal memory is copied to the removable memory card on a regular basis. The “Continuous” mode should be selected to benefit from the larger capacity of the memory card. No logs are erased automatically from the external memory card. You must plan the retrieval of the data before the card becomes completely full.

Select the Period option to set time interval between each log entry (days hours minutes). You can also select the real time option, the shortest period available, which will save an entry at the end of each channel scan (1 log/cycle).

Once your configuration is done, Press the **Start** button to begin the data logging.
Internal Memory

A progress bar is showing the current mega logger internal memory status. When the Mega logger is running the status LED is green, when stopped the LED is red. The remaining time box is an estimation of the time left before the logger stop (in stop when full mode) or wrap around (in continuous mode). The numbers below the progress bar on the left are the current number of logs and the total number of logs the internal memory could handle. The percentage represents the ratio (Count / Total).

Use the **Clear** button to delete all the logs.

Use the **View** button to open log viewer window.

Use the **Save** button to save logs to a file. First define the time period desired (all logs or specific period) and click **OK** to save.

The data retrieved via the Save button are saved in “.csv” format, which can be read in any spreadsheet software (like Excel®). Depending on your local parameters, the spreadsheet software may have some problems to interpret correctly the column separator “;” and the decimal separator “.”. In that case, save your “.csv” file in “.txt” file, open the “.txt” file in the spreadsheet software and follow the instruction on the parameters screen of the opened text file. If the file as more than 65535 lines, Microsoft Excel 2003 and beyond will not be able to open it. Excel 2007 has a limitation of 1048576 rows.
**Memory Card**

On the EasyGrid unit, there is a removable memory card, which is used to increase mega logger capacity. Internal logs are copied to the card on a regular basis. They are saved in a special format, readable only by the Nortech Client software with the log viewer.

A progress bar shows the current memory card space and total capacity.

Use the **Clear** button to delete all logs on the memory card.

Use the **View** button to open log viewer window.

Use the **Synch** button to force synchronization of internal logs to memory card, this operation will update the memory card. You must synchronize before removing the memory card or before opening the viewer, to register the latest logs.
Event Logger

The event logger monitors all state changes of the unit. It is always active and running in “Continuous” mode (erase older logs and continue logging when memory is full).

The state changes which trigger an event log are:

- Sensors states and statistics.
- Relays states
- System status

The types of event available in this log are

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Info</td>
<td>All data in the event are normal</td>
</tr>
<tr>
<td>Warning</td>
<td>At least one data in the event need attention</td>
</tr>
<tr>
<td>Error</td>
<td>At least one data in the event is abnormal</td>
</tr>
</tbody>
</table>

The subtypes of event available in this log are

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>(System Status changes will trig System event)</td>
</tr>
<tr>
<td></td>
<td>Contact Fiso Technical support for this event if you have a different value then “Ok” or “40”</td>
</tr>
<tr>
<td>Relay</td>
<td>(Relay State changes will trig Relay event)</td>
</tr>
<tr>
<td></td>
<td>On / Off</td>
</tr>
<tr>
<td>Sensor</td>
<td>(Sensor State and Statistics changes will trig Sensor event)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Channel</th>
<th>State</th>
<th>Current temp.</th>
<th>Temperature stats.</th>
<th>Diagnostic</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Min.</td>
<td>Avg.</td>
</tr>
</tbody>
</table>

A progress bar shows the current event logger internal memory status. The actual number of log versus the maximum capacity of the allocated space in the memory is showed below the left side of the progress bar. The percentage also represents this ratio (Count / Total).

Use the **Clear** button to delete all the logs.

Use the **View** button to open log viewer window.

Use the **Save** button to save logs to a file. First define the time period desired (all logs or specific period) and click **OK** to save.

The data retrieved via the Save button are saved in “.csv” format, which can be read in any spreadsheet software (like Excel®). Depending on your local parameters, the spreadsheet software may have some problems to interpret correctly the column separator “;” and the decimal separator “.”. In that case, save your “.csv” file in “.txt” file, open the “.txt” file in the spreadsheet software and follow the instruction on the parameters screen of the opened text file. If the file as more than 65535 lines, Microsoft Excel 2003 and beyond will not be able to open it. Excel 2007 has a limitation of 1048576 rows.
Log viewer

Mega logs viewer

The log viewer is used to browse through the logs and display them without stopping the acquisition. Data can be filtered, searched, zoomed and saved.

To download a specific time period of the logs, use the Download toolbar button. Set the desired period and click OK. Use the Stop button to stop downloading.
Grid

In the grid view, you can select the information you want to see using the **Type** filter. Depending if you are in Standard or Enhanced Mode, different filters will be available such as relays status, sensors measurements, sensors statistics and internal temperatures.

<table>
<thead>
<tr>
<th>Filter type</th>
<th>All</th>
<th>Relays</th>
<th>Sensors</th>
<th>Current temp.</th>
<th>Temperature stats.</th>
<th>Diagnostic</th>
<th>Internal temp.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Min.</td>
<td>Avg.</td>
<td>Max.</td>
</tr>
<tr>
<td>Sentinel II Standard</td>
<td>☑️</td>
<td>☑️</td>
<td>☑️</td>
<td>☑️</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sentinel II Enhanced</td>
<td>☑️</td>
<td>☑️</td>
<td>☑️</td>
<td>☑️</td>
<td>☑️</td>
<td>☑️</td>
<td>☑️</td>
</tr>
<tr>
<td>EasyGrid Standard</td>
<td>☑️</td>
<td>☑️</td>
<td>☑️</td>
<td>☑️</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EasyGrid Enhanced</td>
<td>☑️</td>
<td>☑️</td>
<td>☑️</td>
<td>☑️</td>
<td>☑️</td>
<td>☑️</td>
<td>☑️</td>
</tr>
</tbody>
</table>

Search for a specific date and time in the grid is available, just select the date (year-month-day hours: minutes: seconds) and click the **Find** button.

The **Save** button will store the logs in “CSV” format. The file will become available once all the logs of the selected period have been downloaded.
In the graphical mode, you can select the information you want to display (value, maximum, minimum, average, signal, light) depending of the log type (Standard, Enhanced). Using the checkmark bottom legend you can select the channels and information you want to display. The graph will automatically adjust its bounds to the data to display. *For the chart functionality, please refer to the Graph control functions section.*
Memory Card Viewer

Two options are available to view the data stored on the memory card

1. Accessing the card remotely from the unit.
2. Reading the card directly in your PC with a memory card reader.

Log browsing and loading will be much faster using the second option.
Remote

Launch the viewer with the View button in the memory card info of the Data Logging tab. The tree view of the logs will be loaded automatically.

Every log file contains one day of logs. If you click on a date, the log download of this day will begin. You can also download a complete month, by right-clicking the node, and select Download. For a specific time period, use the Download button on the toolbar, set the wanted period and click OK to download. The download progression is display on the window. You can stop the download anytime with the Stop toolbar button. If you want to delete a particular day of log or an entire month, use the right mouse button on the tree node to show the context menu and click on Delete.

Tree view and download logs
PC

Once connected to your PC, memory card files can be backup to your local drive, be sure to copy the entire “info” and “log” folders to the same archive directory, if you want to be able to load them with the software.

To open the viewer, use the Tools menu -> Memory Card Files Viewer, or click on the Memory Card toolbar button.

Then use the Open toolbar button to browse computer and select the root directory of the memory card, or an archive folder. Select the parent directory which contains “info” and “log” folders. The logs structure should now be loaded in the tree view.
Event logs viewer

The viewer can be opened via the View button in the Event logger status section of the Data Logging tab. User can browse through the logs and search for a specific date and time (year-month-day hours:minutes:seconds).
Relay tab

The **relay tab** is used to configure and monitor relay information of the selected unit in the device list.

![Relay tab](image)

**Alarm config**

For each relay, alarm conditions can be configured to raise an alarm when certain conditions are met.

First, to turn on the alarm, set the Function to Enable. You can write a short description of the alarm. Set the logic to define alarm conditions either on the temperature sensor or the internal temperature of the system.

With logic OR, AND, AVERAGE, an alarm condition is considered true, when the channel temperature reading is outside of the defined range. Select one or more channel you want to monitor. When a single channel is selected, logics OR, AND, AVERAGE will behave the same way, the relay is active when the condition is true. If there are two or more channels selected, the logics behaviors are:
• OR: relay is active when at least one channel condition is true.
• AND: relay is active only when all conditions are true.
• AVERAGE: the condition is applied on the average temperature of the selected channels and the relay is active when the condition is true.

For logic OR and AND, a dropdown gives you the choice to define Single or Multiple set point(s). Select “Single” to set the same set point on each channels selected or select “Multiple” to define different set points on channels.

Heater and cooler control logics are used in relation with the Nortech internal system temperature. Select HEATER_CTRL to raise an alarm when the internal temperature is too low, or select COOLER_CTRL to raise an alarm when the internal temperature is too high.

For each set point condition, you must define a hysteresis which is a debouncing value to prevent rapid switching of the relay state as the temperature drifts around the set point.

An alarm condition is considered true when the temperature is outside of the defined range (lower than minimum, higher than maximum). The alarm will return to false (normal) when temperature goes back inside the range limits (higher than minimum + hysteresis, lower than maximum – hysteresis).
A seasonal period can also be defined, when your alarms conditions must be offset for a particular season in the year. During that period, the seasonal offset will be added to the set point value (minimum and maximum) to define the condition.

Leave the seasonal offset to 0, if you don’t need this feature.
**Example**

For example, with:

Minimum -20°C, Maximum 100°C, Hysteresis 2°C, Seasonal Offset 10°C

The maximum alarm condition starts at 100°C and it be reset at 98°C (100 – 2)

The minimum alarm condition starts at -20°C and it be reset at -18°C (-20 + 2).

During the seasonal period:

The maximum alarm condition starts at 110°C (100 + 10) and it be reset at 108°C.

The minimum alarm condition starts at -10°C (-20 + 10) and it be reset at -8°C.
**Relay config**

The relay operation can be set to:

- **Normal mode:** after powering up, relay will remain de-energized, and in case of alarm, relay will be energized.
- **Fail Safe mode:** after powering up, relay will be energized, and in case of power outage, cut supply wiring or alarm, relay will be de-energized.

The activation delay represents the time that the alarm conditions must be true before switching the relay status. The alarm will only be raised when the time is up. **Leave the activation delay to 0, if you don’t need this feature.**

The test lockout is a feature to prevent testing or exercising a relay. The relay will only change state when an alarm is raised.

The exerciser is a special mode which will switch the relay state to active, when there is no alarm, but you want to activate a fan or something else to exercise it. Set the time duration and the cycle period and the relay will be activated by midnight.
System relay

On Sentinel II, the system relay operation can be set. On EasyGrid, the system relay is always in Fail Safe mode.

The operation modes are:

- **Normal mode**: When powering up, relay will remain de-energized, and in case of alarm, relay will be energized.
- **Fail Safe mode**: When powering up, relay will be energized, and in case of power outage, cut supply wiring or alarm, relay will be de-energized.

Relay status

The relays status indicators are showing the relay state.

The status indicators colors are:

- **Black**: alarm function is disable. No alarm.
- **Green**: alarm function is enable and the alarm conditions are not met. No alarm.
- **Red**: alarm function is enable and the alarm conditions are met. There is an alarm.
- **Yellow**: alarm function is enable, no alarm, but exercising ( simulating an alarm ).
**Hardware tab**

**Channel Setup & Analog Output Scale**

If you are not planning to use all the channels on your unit, it is better to disable the unused one. The system alarm will ignore all disable channel status. To activate a channel, check it. To disable a channel, uncheck it. You may write a short channel description for each sensor. If you want to apply an offset to the sensor reading, set the offset or leave it to 0. For analog output, you can define the temperature range you want for minimum and maximum value. The temperature range should be between -40°C to 225°C. The following table summarizes the correlation between the temperature minimum and maximum readings and the corresponding analog output value.

<table>
<thead>
<tr>
<th>Scale</th>
<th>Temperature</th>
<th>4-20 mA</th>
<th>0-1 mA</th>
<th>0-10 V</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum</td>
<td>-40°C</td>
<td>4 mA</td>
<td>0 mA</td>
<td>0 V</td>
</tr>
<tr>
<td>Maximum</td>
<td>225°C</td>
<td>20 mA</td>
<td>1 mA</td>
<td>10 V</td>
</tr>
</tbody>
</table>

To save your changes, click the apply button.
Here are the formulas for the Analog Output.

The Analog Output is represented by a straight line equation of this form: \( y = m x \)

<table>
<thead>
<tr>
<th>Formula</th>
<th>( (y °C - \text{AnaOutMin °C}) = m \frac{°C}{mA} \times (x mA - \text{AnaOutMin mA}) )</th>
</tr>
</thead>
<tbody>
<tr>
<td>( m )</td>
<td>( m \frac{°C}{mA} = \frac{(\text{AnaOutMax °C} - \text{AnaOutMin °C})}{(\text{AnaOutMax mA} - \text{AnaOutMin mA})} )</td>
</tr>
<tr>
<td>( y )</td>
<td>( y °C = \left( m \frac{°C}{mA} \times (x mA - \text{AnaOutMin mA}) \right) + \text{AnaOutMin °C} )</td>
</tr>
<tr>
<td>( x )</td>
<td>( x mA = \left( \frac{(y °C - \text{AnaOutMin °C})}{m \frac{°C}{mA}} \right) + \text{AnaOutMin mA} )</td>
</tr>
</tbody>
</table>

Where:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog Output Min (°C)</td>
<td>AnaOutMin °C</td>
</tr>
<tr>
<td>Analog Output Max (°C)</td>
<td>AnaOutMax °C</td>
</tr>
<tr>
<td>Scale factor (°C / mA)</td>
<td>( m )</td>
</tr>
<tr>
<td>Current Output I (mA)</td>
<td>( x )</td>
</tr>
<tr>
<td>Temperature output T°</td>
<td>( y )</td>
</tr>
</tbody>
</table>

All channels share the same original, factory-set, configuration: the scale factor is 16.56 °C/mA.

This setting results in the 0 °C offset to be at 6.41 mA, the minimum 4 mA scale limit to be at -40 °C and the maximum 20 mA scale limit to be at 225 °C.
For example, as for channel 3 in the Monitor screen shoots below; if the loop reads 11.39 mA, the corresponding temperature for that channel is then 82.4 °C.

\[(11.39 \text{ mA} - 6.41 \text{ mA}) \times 16.56 \text{ °C/mA} = 82.4 \text{ °C}\.

**System date and time**

User must set a valid date and time in their system, to have valid timestamps in the logs.

Sentinel Lite does not keep their system time.

To update the system date and time, there are 3 options available:

**Set Local** button will set the system time to the current local PC time.

**Set GMT** button will set the system time to the current UTC/GMT time based on PC time.

**Set To** button will set user defined date and time.
Front panel led output

On Sentinel II, you can choose to either display sensor status or relay (1 to 6) status on the Sentinel front panel LEDs.

![Front panel led output](image)

Transformer information

This section can be used to define personalised information of the transformer monitored by the Nortech.

Use the Apply button to set the transformer information.

Use the Refresh button to refresh information from the unit.

![Transformer info](image)
Firmware update

To open firmware update window, click on the Firmware Update button in the main toolbar or in the Tools menu.

**IMPORTANT**

Be sure to have a valid firmware file provided to you by Fiso. We recommend connecting directly to the unit to upgrade. Upgrading a device over a network is not recommended.
To update firmware:

1. Click on the Select firmware file button and browse the firmware file (.he3) location.
2. Click on the Upload firmware button.
3. For Sentinel unit with older firmware, you will need to boot up your Sentinel in firmware update mode (see procedure below).
4. Watch progression and wait for completion message.
5. Unit reboots and new firmware version is displayed

Sentinel firmware update mode (if needed):

1. Turn power switch to off.
2. Hold down Mode / Cancel button on the left.
3. Turn power switch to On
4. Release Mode / Cancel button.
5. The unit LCD display should be blank (all blue, no characters displayed) and system status led Red (Missing or Corrupted Firmware) or Amber (Normal State).
If a problem occurred while uploading firmware (bad communication, bad firmware file, power lost, etc), you might end up with a corrupted firmware. You will have the ability to upload it again.

When a soft sector is corrupted, the unit won’t boot up normally. It will stay in the firmware update mode (blank blue screen). A red system status led on the front panel also indicates a corrupted soft sector (firmware).

Unit might need to be rebooted for the firmware upload to work properly.

Be sure you have the right Firmware file selected and try uploading again.

Contact us, to get latest Firmware file.
User configuration archive

The user configuration archive is a feature that allows you to backup and restore all the customization you have done to the instrument configuration. The archive file can also be used to copy the same configuration to multiple instruments.

To save the user configuration of a device, connect the device you want to backup to your PC, select it in the “Devices list” and use the File menu -> Save user config.

To load a user configuration archive file to the current selected device, use the File menu -> Load user config, browse for the proper file. Once loaded, the device configuration will be updated with the configuration from the selected archive file.

Updated data are:

- Data logging configurations (log type, memory mode, period) (when mega logs are empty and not running)
- Relay configurations (description, conditions, relay operation mode, delay, exerciser, seasonal period)
- Hardware configurations (channel enable, description, offset, min & max analog output, front panel LEDs)
Graph control functions

Legend

Refer to the bottom chart section for the color legend. Each channel color is identified. Uncheck a color to hide it from the chart. A right click on the legend, display the “Show all” or “Hide all” option which check or uncheck series.
**Zoom**
To zoom in on a Chart, press the **left mouse button** at the top left hand corner of the area you wish to zoom in on and, maintaining the mouse button pressed, drag out the rectangle to the bottom right hand corner of the zoom area. Releasing the mouse button will force the Chart to redraw the area selected. To undo the zoom, press the left mouse button anywhere on the Chart area and drag up and left with the mouse button depressed. Releasing the button will force the Chart to redraw to the originally defined Chart area.

**Scroll**
To scroll a Chart across, press the **right mouse button** and, maintaining the mouse button pressed, drag the mouse in the direction you wish to scroll the Chart. When you release the mouse button the Chart will remain at the new location. To undo the scroll, press the left mouse button anywhere on the Chart area and drag up and left with the mouse button depressed. Release the button and the Chart will redraw to the originally defined Chart area.

**Save**
Use the save button on the chart toolbar, to launch the Export Window. From there, you can save the chart as a picture or export the data to a file. Choose the series to export, the file format, data to include, column separator and click Save. To get date time value of the X column, in Microsoft Excel, change the column format to a Date time or custom date format like “yyyy-mm-dd hh:mm:ss”.

![Chart Save](image)